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Preface
Scope
This manual describes how to operate the TEAM SC 553 Network Manager, Version 3.0.0. It 
assumes familiarity with HP OpenView.

The TEAM SC 553 software is an HP OpenView application that employs the Simple Network 
Management Protocol (SNMP) to configure and control the operation of GDC SpectraComm 
553 Data Service Units (DSUs). The DSUs support DTE interface functions and provide frac-
tional T1 capability on the network. 

This manual assumes a working knowledge of DSU functions and operation. 

Revision History
This is the initial issue of the manual for Version 3.0.0 of the TEAM SC 553 product. The 
immediately preceding version was 1.2.0.

This software has been tested to be Year 2000 Compliant in accordance to GDC ENG-STD-003. 
Check GDC's web site at http://www.gdc.com for the latest year 2000 information.

This release also includes support for the Fault Tolerant Switching (FTS) network application. 

Version 1.2.0 differed from Version 1.1.0 through

• addition of functions related to the DSU’s optional optional cascade port interface 

• revised presentation format for Reports data 

• addition of icon tool bars to some screens

Version 1.1.0 differed from Version 1.0.0 through the addition of two features: Statistics Polling, 
and Save to File capability for the Reports function. 

Organization
This manual has six chapters. The information is arranged as follows:

• Chapter 1 - Introduction describes the product and its features.

• Chapter 2 - Operation provides directions for accessing the smaller individual 
applications that are responsible for the TEAM SC 553 functions. It describes how to 
access the functions from a shelf map window menu bar, and from the Select menu of a 
DSU front panel display. The chapter provides full descriptions of the TEAM SC 553 
applications that display read-only windows. It provides access information for the 
applications that display read/write windows and require greater operator interaction. 

• Chapter 3 - Configuration provides instructions for accessing the Configuration 
application and using it to set operating parameters in a selected DSU. The chapter covers 
how to save configuration changes to the unit or as templates at the controller workstation, 
and defines the parameters you can set. 

• Chapter 4 - Maintenance provides instructions for accessing the Maintenance application 
and using it to control functions of the DSU. 
GDC 058R740-V300, Issue 1
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• Chapter 5 - Diagnostics provides instructions for accessing the Diagnostics application 
window and using it to perform test procedures. 

Document Conventions

Level 1 paragraph headers introduce major topics.

Level 2 paragraph headers introduce subsections of major topics.

Level 3 paragraph headers introduce subsections of secondary topics.

Related Publications
The following documents have additional information that may be helpful when using this 
product:

•  SC 553 Data Service Unit 
Operation and Installation Manual 058R155-000

GDC publication numbers are used to track and order technical manuals. Publication numbers use 
the following format: 

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn

NNN identifies the product family 

R denotes a technical publication

nnn a number assigned by Technical Publications

000 identifies a hardware product and does not change

Vnnn the software version associated with a product may be updated periodically

The Issue Number changes when a manual is revised or reprinted with changes for some other 
reason; it does not automatically change when the software is updated. A new Software Version 
is always Issue 1. Other specialized publications such as Release Notes or Addenda may be 
available depending on the product.

Service and Support
General DataComm is committed to providing the service and support needed to install, manage, 
and maintain your equipment. For information about service programs or for assistance with your 
support requirements, contact your local Sales Representative or call General DataComm Service 
at the 24-hour toll free number listed below.

• in the U.S. dial 1-800-243-1030

• outside the U.S. dial 1-203-598-7526

Be ready with the site name and phone number and a description of the problem and the next 
available support representative will promptly return your call.

Hands-on training courses are provided by GDC Educational Services. Courses range from basic 
data communications, modems and multiplexers, to complex network and ATM systems and are 
taught in Connecticut or at a customer location. Call 1-800-243-1030 and follow the menu 
instructions to discuss educational services or to receive a course schedule.

Notes present special instructions, helpful hints or general rules.

NOTE
GDC 058R740-V300, Issue 1
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1  Introduction
Overview
This manual covers the General DataComm TEAM SC 553 Unix Application for HP OpenV
You should be familiar with HP OpenView and with the operation of digital data service u
(DSUs) in order to use this manual effectively. 

The TEAM SC 553 Unix Application is actually a collection of integrated applications for t
HP OpenView Network Management Platform. The applications use the Simple Network
Management Protocol (SNMP) to manage GDC SC 553 Data Service Units (DSUs). 

TEAM SC 553 applications enable you to 

• Configure SC 553 DSUs. 

• Monitor the operation of the DSUs through displays of Alarms and DTE Interface St
and through a Front Panel display that shows LED indicators as they appear on the
panel of the physical unit. 

• Diagnose suspected problems using local and remote loops (with or without an inte
generated test pattern). 

SC 553 DSU
The SpectraComm 553 DSU provides interface to Fractional T1 (FT1) services for one ch
of user data. It gives you the flexibility to utilize only the bandwidth you need, from 56 Kbp
to the full T1 rate of 1.536 Mbps. 

The DSU provides T1-, DS0-, and channel-level diagnostics for extensive diagnostic capab
that can be commanded from the TEAM SC 553 application. 

SpectraComm Manager Card
The DSU operates in conjunction with a GDC SpectraComm Manager (SCM) card to pro
comprehensive network management capabilities using the Simple Network Managemen
tocol (SNMP). The SCM acts as the SNMP agent through which TEAM management app
tions communicate with SC 553 DSUs and other compatible equipment. 

All management communications are directed to the SCM card Internet Protocol (IP) add
The SCM card relays commands and responses between management applications and h
components, using a slot addressing scheme to communicate over the SpectraComm she
plane with the other components. The SCM is transparent to the applications, which ope
though they were communicating directly with the hardware units. The SCM card is mana
by the TEAM Core application, which is also responsible for the Discovery and Mapping 
tions by which HP OpenView keeps track of the devices being managed. 
GDC 058R740-V300, Issue 1
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TEAM SC 553 Applications
The applications that make up the TEAM SC 553 manager are grouped on menus under 
headings Performance, Configuration, Fault, and Misc (Miscellaneous). Menus for the 
applications are available in two ways: 

• From the menu bar of the HPOV Map window when an SC 553 DSU is selected in t
window 

• From the Select button on the SC 553 Front Panel display. 

SC 553 Front Panel displays current status information on the SC 553 DSU by displaying
states of the LED indicators on the front panel of the unit; provides Select button menus by 
you can invoke all other functions of the TEAM SC 553 manager. Front Panel is a selectio
the Performance menu in the HPOV Map window menu bar. You can also launch the Front
display from that window by double clicking on the shelf icon of the DSU you need to work 

The following TEAM SC 553 applications appear on both the Map window and Select butt
menus:

• Performance: 

Statistics Polling – displays accumulated total counts of error conditions

Alarm Detail – furnishes detailed information about alarm state changes 

DTE Status – displays information on the current status of signals in the DTE i
face 

Reports – displays detailed information on operations over the past 24 hours 

Current Interval Reports – displays information on operations during the curren
minute period 

• Configuration:

Configuration – enables you to configure a selected SC 553 DSU 

Maintenance – enables you to set device specific attributes that are not set as 
uration options

• Fault: 

Diagnostics – enables you to run diagnostic tests on a selected SC 553 DSU

• Misc: 

Information – displays revision level information on the TEAM SC 553 software

The Misc menu in the Map window menu bar contains two selections that do not app
the Front Panel Select button menu: 

Front Panel Poll Rate – enables you to set a default polling interval to be in eff
each time the Front Panel display is opened 

Note Pad – opens a shell tool on the workstation running the TEAM software. 
can use the shell tool to run a text editor, mail tool, or any other software that re
on the workstation. The Note Pad application provides this access for keeping
records on the system. 
GDC 058R740-V300, Issue 1
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2   Operations
Introduction
The TEAM SC 553 controller application consists of a group of smaller applications, each
devoted to a specific aspect of controlling or monitoring SC 553 DSUs. There are two mea
access to the TEAM SC 553 applications: the map window menu bar, and the Front Pan
window Select button menus. This chapter describes both. 

In the Performance category of both menus there are five applications that display read-o
windows: Statistics Polling displays counts of error events, Alarms displays alarm informa
Status displays the status of signals in the DTE interface; Reports displays information o
variety of error conditions that may be experienced by the DSU over a 24-hour period; Cu
Interval Reports displays the most recent information concerning error conditions. The m
window Performance menu also includes a selection for launching the Front Panel display
chapter fully describes all six applications. 

There are two applications in the Configuration category: Configuration and Maintenance.
supports read/write windows by which you can review and alter unit operating parameters
chapter describes how to access the Configure and Maintenance applications. Instruction
using the two applications appear in subsequent, individual chapters. 

The Fault menu provides access to the Diagnose application by which you can command
functions of the units and view test results. This chapter describes how to access the Dia
application. Instructions for its use appear in a subsequent chapter. 

Three items appear on menus as Misc (miscellaneous): Information, Front Panel Poll Ra
Note Pad. Only the first of those appears on the Select button menu of the Front Panel d

Map Window Menu Bar Access
The table on the following page illustrates how the TEAM SC 553 application functions a
arranged on the menu bar at the top of the HPOV Map window. The table shows only the
selections for the TEAM SC 553 applications. The map window menus include selections
addition to those that apply to TEAM SC 553 because the window also provides access to
applications. 

You must select the unit you intend to work with before you open the menu you intend to
Select the unit by clicking the mouse once on its icon in the map.

The menu item Agent Templates, which appears under Misc in the 
menu listing on the next page, does not apply to SCM-based 
applications such as TEAM SC 553. The use of that function is 
therefore not documented in this manual. 

Its functionality is employed by standalone TEAM application 
products such as TEAM 540 and TEAM 553. The Agent Templates 
function is documented in the manuals for those products. 

NOTE
GDC 058R740-V300, Issue 1
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The Performance menu Front Panel selection opens the Front Panel display window. The
button menus in the Front Panel display window include the selections that appear above
the exceptions of Front Panel under Performance, and Front Panel Poll Rate and Note Pa
Misc. 

SC 553 Front Panel
The SC 553 Front Panel display windows provide graphical interface to a selected DSU. T
launch a Front Panel, select the unit you intend to work with in the HPOV Map window, th
either select Front Panel from the Performance menu for that window or double click the m
on the icon for the selected unit. 

The application responds by displaying a window that depicts the front panel of the selecte
shown in Figure 2-1. 

Menu Bar Menu Selections

Performance

Front Panel...

Statistics Polling...

Alarm Detail...

DTE Status... 

Reports... 

Current Interval Reports... 

Configuration

Configuration...

Maintenance...

Fault

Diagnostics...

Misc

Agent Templates...

Information...

Front Panel Poll Rate...

Note Pad...
GDC 058R740-V300, Issue 1
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The application polls the unit to keep the states of the LEDs in the Front Panel display cu
The time of the most recent poll appears in the bottom left corner of the Front Panel displa
time is displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The Select button, at the bottom of the Front Panel displays provides access to menus for 
of the TEAM SC 553 application functions. The following table shows the arrangement of 
Select button menus. It differs somewhat from the arrangement on the Map window menu

The LEDs shown in a Front Panel display reflect the states of the actual indicators on the physical u

Figure 2-1 SC 553 DSU 
Front Panel

INS In Service normally remains On continually after the DSU 
successfully completes its power-on test; can be caused to 
blink continually by the Blink INS menu selection 

ON Power On

RSP Response indicates when lit that a packet has been transmit
through the management port

SD Send Data indicates when lit that a space is detected in tran
mit data

RD Receive Data indicates when lit that a space is detected in 
receive data 

EQ Equipment indicates when lit that the cascade interface is 
installed

OOF Out of Frame indicates when lit that the unit cannot synchro
nize to the network signal

LOS Loss of Signal indicates when lit that the unit has lost the ne
work signal

BPV Bipolar Violations indicates when lit that the unit has detecte
bipolar violations in the network signal

AIS Alarm Indication Signal indicates when lit that the unit has 
received an Alarm Indication Signal from the network 

TM Test Mode is lit red while the unit performs a Local Loop 
diagnostic test 

ALM Alarm, indicates by its color, which matches that of the map
icon for the unit, that the unit has detected an alarm conditio

T1 is lit red while the unit performs a T1 diagnostic test 

CH is lit red while the unit performs a Channel diagnostic test 

RL is lit red while the unit performs a Channel Remote Data Loo
diagnostic test 
GDC 058R740-V300, Issue 1
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The two Poll selections in the Select button menu determine – for the current session – wh
application is to collect new information from the unit to update the Front Panel window: 

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disab
automatic polling. If you select Disable, the Front Panel window displays a static snap
of the LED states as they were at the last poll, either when the window was launche
subsequent Demand Poll. 

Select Menu Items Menu Selections

Performance

Statistics Polling...

Alarm Detail...

DTE Status...

Reports... 

Current Interval Reports...

Configuration

Configuration...

Maintenance...

Fault

Diagnostics...

Misc

Information...

Demand Poll

Auto Poll (*)

* Displays Off or 
selected poll 
interval

15 seconds

30 seconds

60 seconds

Disable

Blink INS (*)

* Displays On or Off On

Off

Exit
GDC 058R740-V300, Issue 1
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The Blink INS selection, when set to On, causes the In Service indicator to blink continuous
the SC 553 DSU being controlled. When you determine that a unit requires replacement o
on-site attention, this feature enables you to identify it for easy location by on-site personne
menu selection is grayed out when the SC 553 DSU being controlled by the application is an
revision that does not support this feature. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Fr
Panel Poll Rate selection of the HPOV map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Common Window Features
Each TEAM SC 553 application you select opens an on-screen window in which to opera
number of features are common to many of the windows: 

Triangle button – in the title bar; reduces the window to an icon when you click on it. Dou
clicking on icon restores the window. This button appears on the top leve
window for each application.

Title bar – identifies the specific TEAM SC 553 application running in the window; f
example TEAM SC 553 Main Configuration or TEAM SC 553 Diagnostics

Menu bar – always contains the selections File, on the far left, and Help, on the far r
File menu always contains the selection Exit, by which you can dismiss t
window; some window File menus contain selections special to the windo
Help menu provide access to information concerning the window. Some 
windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A M
bar appears in the Main Configuration window, for example, but not in the
windows you access from Main Configuration.

Name field – identifies the SC 553 the application is currently connected to by displayin
user-configured shelf name, followed by the DSU slot number, and the u
configured device name. 

Descriptions in this manual of the individual TEAM SC 553 applications identify window 
features that are specific to the applications, such as selections in the Menu bar and men
buttons. 

Performance Functions
Statistics Polling

You can launch the TEAM SC553 Real Time Statistics application from the Performance M
of the Map window or from the front panel menu. The selection appears as Statistics Polli
both menus. 

The body of the Real Time Statistics window is divided into two panels: 

• Statistics Totals contains eight display fields and a button labeled Clear Totals. Seve
the display fields show total occurrence counts of error conditions that the DSU mon
the eighth shows Percent of Error Free Seconds. The displayed totals are the count
accumulated either since the TEAM SC553 application started running or since the 
time the Clear Totals button was clicked. 

• Statistics Polling contains the Poll Interval field and the Poll Time display. You can se
the Poll Interval for the window to be 5 seconds (default), 10 seconds, 15 seconds, 
GDC 058R740-V300, Issue 1
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seconds. When you change the Poll Interval, the application automatically saves the
value. The Poll Time display shows the time period over which count totals have bee
accumulated. Poll Time is initialized when the TEAM SC5531 application starts runn
and when the Clear Totals button is clicked. 

The footer, bottom margin, of the Real Time Statistics window displays two items of informa

• Status, in the left corner, indicates whether or not the SC 553 DSU is presently respon
to polling; it displays either Unit Responding or Unit Not Responding. 

• History , in the right corner, provides indication of past polling problems; it displays N
Errors when all polls have been responded to, and it displays Poll Failed when there
been a poll without a response. The Poll Failed message remains on display, even w
successful polling has resumed, as an indication that counts may be inaccurate. The H
display returns to No Errors when you reset the counts by clicking on the Clear Tota
button. 

Figure 2-2 illustrates the Real Time Statistics window. 

Figure 2-2 Real Time Statistics Window

Alarm Detail

You can launch the TEAM SC 553 Alarm Detail application from the Performance menu o
HPOV Map window menu bar or of the Front Panel display Select button menu. The applic
displays the read-only Alarm Detail window for the selected unit (See Figure 2-3).

The TEAM SC 553 application gets alarm indications from the unit in two ways: 

• By receiving traps sent automatically in response to alarm conditions at the unit 

• By polling the unit for changes in alarm conditions 
GDC 058R740-V300, Issue 1
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Figure 2-3 Alarm Detail Window

The Alarm Detail window displays alarms grouped into six categories: 

• Network

• Channel

• Cascade

• Unit 

• Informational

• Power Supply (valid only for SC 2000 shelf)

Network Alarms

Loss of Signal – indicates that the unit is not receiving a signal from the network 

Out of Frame – indicates that the unit cannot synchronize to the signal from the network 

Alarm Indication Signal – indicates that the unit has received an AIS from the network 

Unavailable Signal State – indicates that the unit has detected at least 10 severely errored 
at its network interface 

Tx Timing Loss – indicates that the unit has lost Transmit Timing 

Received Yellow – indicates that the unit has received a Yellow alarm from the network 

Bipolar Violations – indicates that the unit has detected bipolar violations at its network inte

CRC Errors – indicates that the unit has detected Cyclic Redundancy Checksum errors a
GDC 058R740-V300, Issue 1
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network interface 

Low Average Density – indicates that the unit has detected violations of ones density 
enforcement at its network interface; occurs only when unit is configured for 8(N+1) Restr

Channel Alarms

DCD Loss – indicates that the unit cannot recover data from the incoming signal at the ne
interface 

DSR Loss – indicates that the unit is not outputting Data Set Ready to the DTE 

DTR Loss – indicates that the unit is not receiving the DTR signal from its DTE 

External Tx Clock Loss – indicates that the unit has lost External Transmit Timing from its D
occurs only when unit is configured for External Timing

RxD No Transitions – indicates that Receive Data being output to the DTE by the DSU co
of all ones or all zeros 

TxD No Transitions – indicates that Transmit Data coming to the DSU from the DTE consis
all ones or all zeros 

Cascade Alarms

Loss of Signal – indicates that the unit is not receiving a signal at the cascade port 

Out of Frame – indicates that the unit cannot synchronize to the signal at the cascade por

Alarm Indication Signal – indicates that the unit has received an AIS at the cascade port

Unavailable Signal State – indicates that the unit has detected at least 10 severely errored 
at the cascade port 

Received Yellow – indicates that the unit has received a Yellow alarm at the cascade port

Bipolar Violations – indicates that the unit has detected bipolar violations at the cascade p

CRC Errors – indicates that the unit has detected Cyclic Redundancy Checksum errors a
cascade port

Unit Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the unit configu
has become corrupted

Front Panel Test – occurs each time the unit is commanded into a test mode by its front p
switches 

Unit Failure – indicates that the unit has failed its power on self test 

Unsolicited Test – occurs each time the unit is commanded into a test mode by any mean
than SNMP or its front panel switches 

Config Change – occurs each time unit configuration is changed 

Informational Alarm

Power Up – occurs each time power is cycled or a reset is performed at the unit
GDC 058R740-V300, Issue 1



Operations 2-9

wer 
tions 

ower 
tions 

POV 
plays 

ace 

 Poll, 

tomatic 
ators 
nd Poll. 

 is 
Power Supply Alarms

Top Supply Fail – valid only for SC 553 DSU installed in SC 2000 enclosure that has a po
supply installed in the upper power supply location; occurs when that power supply malfunc

Bottom Supply Fail – valid only for SC 553 DSU installed in SC 2000 enclosure that has a p
supply installed in the lower power supply location; occurs when that power supply malfunc

Alarm Detail Window Menus

The Alarm Detail window has the selections File and Help in its menu bar. 

The File menu contains only the selection Exit, by which you can dismiss the window. 

Status

You can launch the TEAM SC 553 Status application from the Performance menu of the H
Map window menu bar or of the Front Panel display Select button menu. The application dis
the read-only Status window for the selected DSU (See Figure 2-4). The window is divided into 
two displays: 

DTE Status displays EIA signal indicators that represent the states of the DTE interf
signals. Dark green indicates Off, light green indicates On, and light green with a 
superimposed two-headed arrow indicates transitions. 

Network Rx Level displays the strength of the signal being received, in dB. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto
and Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable au
polling. If you select Disable, the Status window displays a static snapshot of the EIA indic
as they were at the last poll, either when the window was launched or a subsequent Dema

The time of the most recent poll appears in the bottom left corner of the window. The time
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 2-4 Status Window
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Reports

You can launch the TEAM SC 553 Reports application from the Performance menu of the H
Map window menu bar or of the Front Panel display Select button menu. The application dis
statistics accumulated by the DSU concerning seven types of error conditions and provide
mechanism for saving those statistics to a file. 

When you launch the Report application it initially displays the Error Reports window show 
Figure 2-5. That window is the access point from which you select individual error conditio
displays. It contains four menus in the menu bar at the top of the window, a tool bar consist
display selection buttons, and an End Selection button. 

Figure 2-5 Error Reports Window

The End Selection button determines which of three sets of registers the application read
acquire the data it displays: 

Near End User – selects the registers internal to the SC 553 itself

Near End Network – selects the registers supported by the carrier at the local end of the

Far End Network – selects the registers supported by the carrier at the remote end of the
GDC 058R740-V300, Issue 1
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The menus are 

File Menu

The File menu contains two selections for refreshing the data displayed on-screen, one se
to initiate the procedure for saving Report data to a file, and one selection for dismissing t
Reports application. 

When the Reports application is launched, it reads data for the selected DSU from the regi
selected by the End Selection button. The application continues to display the same data w
updating unless you invoke either the Refresh or the Auto Refresh selection from the File 
The Refresh selection causes the application to perform an immediate read of the selected

Menu Bar Menu Selections

File

Refresh

Auto Refresh Off

Every 1 Hour

Every 4 Hours

Every 8 Hours

Every 12 Hours

Every 24 Hours

Save Error Data to File...

Exit

Edit

Reset Statistics

View

Legend

Navigate

24 Hour Error Totals....

Unavailable Seconds...

Bursty Errored Seconds...

Severely Errored Seconds...

Cyclic Redundance Check...

Loss of Frame...

Controlled Slip Seconds...

Errors Summary...

All Screens...
GDC 058R740-V300, Issue 1



2-12 Operations

 data at 
efresh 

pecify 
ection 

t the 

ow. 
en they 

o the 

 that 

ute 
. The 
set. The Auto Refresh selection enables you to select the application to update the Report
specified intervals. The Reports application continues reading data at the selected Auto R
interval until either the interval is changed or Exit is selected from the File menu. 

The Save Data to File selection of the File menu opens a dialog window in which you can s
the directory path and name of a file for storing formatted Error Reports data. Use of this sel
is explained in detail following the description of the display screens. 

The Exit selection of the File menu dismisses the Reports application. 

Edit and View Menus

The Edit and View menus each contain a single selection. 

The Edit menu’s one selection is Reset Statistics; which causes the application to zero ou
accumulated Reports data in the Near End User registers when it is invoked. 

The View menu Legend selection toggles display of the lower portion of the Reports wind
When the definitions labeled Legend are displayed the selection causes them to be hid; wh
are not displayed the selection causes them to appear.  

Navigate Menu

The Navigate menu and the display selection buttons in the toolbar both provide access t
display windows:

Totals

Errored Seconds 

Unavailable Seconds 

Bursty Errored Seconds 

Severely Errored Seconds 

Cyclic Redundancy Check

Loss of Frame Count 

Controlled Slip Seconds 

Summary 

All Screens 

The Totals screen, first in the Navigate menu, displays total values for the error conditions
the Reports application tracks. The next seven screens display detail information on the 
individual error conditions, displaying the number of error events occurring in each 15-min
interval. The ninth screen, Summary, displays all seven error conditions as interval values
tenth selection in the Navigate menu opens all the Reports windows at once. 
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24 Hour Error Totals

Figure 2-6 Errors Reports Totals Screen 

The screen displays total events over a 24-hour period in two ways. The two large windows 
display graph bars to indicate the magnitude of the total values; and the small window on the right 
displays the specific numeric total values. 

The Errors Summary button in the upper right corner of the window causes the application to 
open the Errors Summary window without closing the Totals window. The Errors Summary 
window is described in detail under its own heading. 

Click on the Close button to dismiss the window when done viewing it. 

Errored Seconds Display Screen

The Errored Seconds display screen graphically illustrates the number of errored seconds that 
occurred during each 15-minute interval of the most recent 24 hours. The window is wide enough 
to display 17 intervals of data at a time, just over four hours. To move through the entire 24-hours 
of data, click on the scroll bar located under the display area and drag it to the right or left to adjust 
the time period being displayed. 
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Figure 2-7 Errored Seconds Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of errored seconds. 

Click on the Close button to dismiss the window when done viewing it. 

Severely Errored Seconds Display Screen

The Severely Errored Seconds display screen graphically illustrates the number of severely 
errored seconds that occurred during each 15-minute interval of the most recent 24 hours. The 
window is wide enough to display 17 intervals of data at a time, just over four hours. To move 
through the entire 24-hours of data, click on the scroll bar located under the display area and drag 
it to the right or left to adjust the time period being displayed. 
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Figure 2-8 Severely Errored Seconds Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of severely errored seconds. 

Click on the Close button to dismiss the window when done viewing it. 

Bursty Errored Seconds Display Screen

The Bursty Errored Seconds display screen graphically illustrates the number of bursty errored 
seconds that occurred during each 15-minute interval of the most recent 24 hours. The window is 
wide enough to display 17 intervals of data at a time, just over four hours. To move through the 
entire 24-hours of data, click on the scroll bar located under the display area and drag it to the 
right or left to adjust the time period being displayed. 
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Figure 2-9 Bursty Errored Seconds Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of bursty errored seconds. 

Click on the Close button to dismiss the window when done viewing it. 

Unavailable Seconds Display Screen

The Unavailable Seconds display screen graphically illustrates the number of unavailable 
seconds that occurred during each 15-minute interval of the most recent 24 hours. The window is 
wide enough to display 17 intervals of data at a time, just over four hours. To move through the 
entire 24-hours of data, click on the scroll bar located under the display area and drag it to the 
right or left to adjust the time period being displayed. 
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Figure 2-10 Unavailable Seconds Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of unavailable seconds. 

Click on the Close button to dismiss the window when done viewing it. 

Cyclic Redundancy Checksum Errors Display Screen

The Cyclic Redundancy Check display screen graphically illustrates the number of cyclic 
redundancy checksum errors that occurred during each 15-minute interval of the most recent 24 
hours. The window is wide enough to display 17 intervals of data at a time, just over four hours. 
To move through the entire 24-hours of data, click on the scroll bar located under the display area 
and drag it to the right or left to adjust the time period being displayed. 
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Figure 2-11 Cyclic Redundancy Checksum Errors Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of CRC errors. 

Click on the Close button to dismiss the window when done viewing it. 

Controlled Slip Seconds Display Screen

The Controlled Slip Seconds display screen graphically illustrates the number of controlled slip 
seconds that occurred during each 15-minute interval of the most recent 24 hours. The window is 
wide enough to display 17 intervals of data at a time, just over four hours. To move through the 
entire 24-hours of data, click on the scroll bar located under the display area and drag it to the 
right or left to adjust the time period being displayed. 
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Figure 2-12 Controlled Slip Seconds Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of controlled slip seconds. 

Click on the Close button to dismiss the window when done viewing it. 

Loss of Frame Count Display Screen

The Loss of Frame Count display screen graphically illustrates the number of frame losses  that 
occurred during each 15-minute interval of the most recent 24 hours. The window is wide enough 
to display 17 intervals of data at a time, just over four hours. To move through the entire 24-hours 
of data, click on the scroll bar located under the display area and drag it to the right or left to adjust 
the time period being displayed. 
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Figure 2-13 Loss of Frame Count Reports Display Screen 

Time intervals are the X, horizontal, axis of the bar graph display.The X Axis button in the upper 
right corner of the window enables you to select how the display is labeled. You can select

Time – each interval is identified by the time at which it was completed

Interval – each interval is identified by a number, with 1 being the most recently completed 

Time & Interval – each interval is identified in both ways

The vertical axis of the bar graph displays the number of frame losses. 

Click on the Close button to dismiss the window when done viewing it. 
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Errors Summary Display Screen

The Errors Summary window displays the number of occurences for each of the seven types of 
error event during each 15-minute interval of the current 24 hours of operation. It also displays 
the total number of occurences for each type of error event during the current 24 hours. 

The main portion of the window displays the 15-minute values. The error events are listed on the 
Y, vertical, axis and the intervals are identified along the X, horizontal, axis. A slide bar below 
the display enables you to scroll horizontally through all the intervals, since the display is not 
wide enough to show them all at once. The X Axis button located on the right above the main 
display enables you to set the labelling of the X axis to be Time, Interval, or Time And Interval. 
Time labels indicate the end time of each 15-minute interval; Interval labels are 0 (current, 
uncompleted interval) through 96. 

The 24 hour total values appear in the smaller panel in the lower portion of the window. 

Click on the Close button to dismiss the window when done viewing it. 

Figure 2-14 Errors Summary Reports Display Screen 

Saving Reports Data to File

You can store statistics for later review and record keeping by selecting Save Error Data to File... 
from the File menu in the main Error Reports window. The function stores the most recent 24 
hours of data, in a format similar to the appearance of the Error Reports Display screen. 

The menu selection opens a dialog window in which you can specify the directory path and file 
name for storing the data. The application automatically appends the file type suffix .rpt to any 
file name that does not already have that suffix. 
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Current Interval Reports

You can launch the TEAM SC 553 Current 15 Minute Interval Error Report application from the 
HPOV Map Performance Menu or from the Front Panel display Select button menu. The purpose 
of the application is to display “snapshot” views of statistics accumulated by the DSU during the 
incomplete current interval. 

The application acquires the statistics it displays on operator command, rather than automatically. 
The window provides three buttons for this purpose below the display area: Read Near End User, 
Read Near End Network, and Read Far End. The display shows only the most recently read 
information, not simultaneous near-end and far-end data. 

The application displays statistics concerning seven types of error conditions divided into three 
sets of graph bars:

• Errored Seconds (ES), Severely Errored Seconds (SES), Bursty Errored Seconds (BES), 
and Unavailable Seconds (UAS) displayed against a selectable vertical scale that extends 
from 0 to 900, 450, or 225 seconds

• Controlled Slip Seconds (CSS) and Loss of Frame Count (LOFC) displayed against a 
selectable vertical scale that extends from 0 to 260, 130, or 65 events 

• Cyclic Redundancy Checksum errors displayed against a selectable vertical scale that 
extends from 0 to 65000, 32500, or 16250 events 

The Set Vertical Scale checkboxes at the top of the window enable you to select the seconds and 
events scales together: 

900, 260, 65000

450, 130, 32500

225, 65, 16250. 

Below the graph bars the window displays numeric counts of the error conditions. 

When viewing this window, you should perform a new read every few minutes to get a sense how 
frequently error events are occurring. Remember that the statistics all reset to zero at the end of 
each 15-minute current interval. 

When you are done viewing the Current Interval Error Report window, select Exit from the File 
menu to dismiss the application. 
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Figure 2-15 Current Interval Error Report Window

Configuration Functions
Configure

You can launch the TEAM SC 553 Configure application from the HPOV Map Configuration 
Menu or from the front panel menu. 

When you launch the application, it initially displays the TEAM SC 553 Configuration window, 
which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating 
configuration

• Save to Unit, which puts the new configuration into use by the unit 

• Load Template, by which you can recall a stored configuration template that you can then 
save to the unit either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation for 
future use as a template 

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 
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• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the read/write windows by which you can configure 
various aspects of DSU operation: 

• CSU Options 

• DSU Options 

• Alarms Reported 

• System Options 

The TEAM SC 553 Configure application is fully described in Chapter 3, Configuration. 

Maintenance

You can launch the TEAM SC 553 Maintenance application from the HPOV Map Configuration 
Menu or from the front panel menu. 

The application displays one read/write window by which you can control some aspects of 
operation that fall outside the scope of the Configure function. The TEAM SC 553 Maintenance 
application is fully described in Chapter 4, Maintenance. 

Diagnostics
You can launch the TEAM SC 553 Diagnostics application from the HPOV Map Fault Menu or 
from the Front Panel display Select button menu. 

The application displays one read/write window by which you can control a variety of test 
functions on a selected DSU. The TEAM SC 553 Diagnostics application is fully described in 
Chapter 5, Diagnostics. 

Miscellaneous Functions
Information

You can launch the TEAM SC 553 Information window by clicking on the GDC logo in a Front 
Panel display. 

Information displays one read-only window that contains the name of the application, software 
revision level information, and copyright information. The File menu in the menu bar contains 
only the selection Exit, by which you can dismiss the window. 

Figure 2-16 TEAM SC 553 Information Window
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Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-17) from the shelf submap Misc 
Menu. The setting you select in this window determines the initial polling rate for Front Pa
displays each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displa
linked to a TEAM Core application, regardless of which individual application you access 
from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

Click on the checkbox for the desired polling rate. The precise polling frequency resulting
a setting of Slow, Normal, or Fast depends on a number of factors. The higher the rate, th
communication and processor capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with tha
selection are not retained when the display is closed. 

The File menu in the menu bar contains the selections Save to File, by which you put a se
into effect, and Exit, by which you dismiss the window. 

Figure 2-17 Front Panel Poll Rate Window

Note Pad

You can launch the Note Pad application from the shelf submap Misc Menu. The applicat
opens a shell tool on the workstation running the TEAM software. You can use the shell t
run a text editor, mail tool, or any other software that resides on the workstation. The Note
application provides this access for keeping records on the system. 
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3   Configuration
Introduction
The TEAM SC 553 Configuration application enables you to set all the options in an SC 5
DSU through a convenient group of configuration windows. 

To Start TEAM SC 553 Configuration 
You can start the TEAM SC 553 Configuration application by either of two methods: 

• Select a DSU symbol on the submap in OpenView, then select the Configuration op
from the Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration an
select Configuration from the resulting menu. 

Templates
You can store configuration settings as templates on the workstation that runs the TEAM S
application. A template stores a configuration for the unit options, and you can store as m
templates as you need. 

To load configuration settings from a template into the DSU you must perform the followi
steps: 

1. Select Load Template from the File menu and select the template from the resulting
window. The application retrieves the configuration settings of the selected templat

2. Select Save to Unit from the File menu. The application makes the template configu
settings the current operating configuration for the unit. 

Configuration Procedure
The following steps describe how to use the configuration application, and illustrate the 
functions of the Main Configuration window menus. 

1. Access the Main Configuration window, either from the submap or from the Front P
display. The application reads the current Main configuration from the unit when you 
the Main window. 

You can select to base your configuration changes on either the current configuratio
stored configuration template. In either case, the unit continues to operate using its
unchanged current configuration. 

The Refresh selection on the Main window File menu causes the application to read th
current configuration from the unit. All changes to all configuration windows that have
previously been saved to the unit or to a template are lost when you select Refresh

2. To edit the current configuration of the unit, proceed directly to the Navigate menu a
scribed below. 
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To edit a template, select Load Template from the File menu and select a template from
the resulting list. 

3. Click on the Navigate button to display a menu of the configuration windows, and sel
the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the inpu
for an option, a window opens to display all the values the field can be set to. Clic
mouse on the value you select. When you change the value or setting of an option, 
plication displays the option name and the new value in white, rather than black, type
remain white until you either save the changes to the unit or a template by means
Main window File menu, or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their s
values in two ways:

• Click on the Reset button to discard changes while keeping the window ope

• Click on the Cancel button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on either theOK 
button or the pushpin icon, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between the
clicking the mouse on the one in which you intend to operate. The Main Configuratio
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made
your changes, click on the File menu button of the Main Configuration window. From tha
menu you can select Save to Unit to save the new configuration in the unit, or select Save
to Template to save it as a template in the workstation. 

6. When you select Save to Unit, the changed configuration becomes the current con
tion for the DSU you are configuring. 

7. When you select Save to Template, a window appears containing a list of existing tem
and a field for entering a new template name. You can select an existing template
overwritten with the new configuration, or enter a name to create a new template. A 
template is available to be loaded by the application and then saved, with or without f
modification, to any unit of the same type. 

Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 

Main Configuration Window
The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the selected unit. From the Navigate 
menu you select the individual configuration windows in which you make changes. The File 
menu commands the storage and retrieval of configuration settings. The functions availab
the Navigate and File menus can also be invoked by clicking selections in the on-screen to
The contents of the two menus appear below. 
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The Main Configuration window title bar displays the application name, TEAM SC 553 Co
uration. The main body of the window contains items arranged under the headings Opera
Software and Hardware that identify the selected unit and provide information about its op
tions. 

The button below the main tool bar, marked with two triangles, toggles display of the wind
information panel. Clicking on that button when the full Configuration window is displayed
causes the information panel to disappear so that the window consists of just the title, men
tool bars. Clicking the button while the window is in its reduced condition restores the full 
Configuration window. 

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare Template dialog window

Exit

Navigate

CSU Options... 

DSU Options...

Alarms Reported...

System Options...

All Screens... 
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Figure 3-1 Main Configuration Window

Main Configuration Window Display

The Main Configuration window displays the following read-only items: 

Name: name assigned to the selected DSU 

Operation

Slot State: Active or Inactive

Operational Status: Online

Software

Serial Number: serial number of the selected unit

Active Firmware Rev:  revision level of the operating code the selected unit is currently 

Standby Firmware Rev: revision level of operating code stored by the selected unit but n
currently in use 

Boot Code Rev: revision level of the boot-up operating code in the selected unit 

MIB Version: revision level of the Management Information Base files in the 
selected unit 

Hardware

Cascade Interface: Installed or Not Installed

DTE Interface Type V.35 or EIA 530 

Shelf Type: SpectraComm 5000 or SpectraComm 2000

Shelf Power: power (in Watts) available in the shelf and number of slots suppo
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The TEAM SC 553 application relies on the SC 553 DSU to indicate when a configuration 
problem has caused an SNMP set error. 

DSU Options
The TEAM SC 553 DSU Options window lets you define channel interface characteristics for the 
unit and assign the DS0s that carry channel data on the T1 line. 

Figure 3-2 TEAM SC 553 DSU Options Window 

Buttons

OK – dismisses the window while retaining the changes you have made. The changes are not 
stored permanently until you perform a Save to Unit or Save to Template at the Main Configura-
tion window. 

Reset – replaces the information in the fields with the most recently read information from the 
unit. Note that this button does not initiate a read of information from the unit.

Cancel – dismisses the window and cancels unsaved changes.

Options

Service State

Port State – determines whether or not the DTE interface is in use.

Options:

In Service specifies that the DTE interface is in use. 

Out of Service specifies that the DTE interface is not in use, the SC 553 is being used as a 
CSU. 
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EIA Control

Data – determines whether or not the unit inverts transmit and/or receive data.

Options:

Tx Norm, Rx Norm inverts neither transmit nor receive data. Default setting. 

Tx Norm, Rx Invert inverts only receive data.

Tx Invert, Rx Norm inverts only transmit data.

Tx Invert, Rx Invert inverts both transmit and receive data.

Set Timing – determines whether or not the unit inverts transmit and/or receive timing.

Options:

Tx Norm, Rx Norm inverts neither transmit nor receive timing. Default setting. 

Tx Norm, Rx Invert inverts only receive timing.

Tx Invert, Rx Norm inverts only transmit timing.

Tx Invert, Rx Invert inverts both transmit and receive timing.

Tx Auto, Rx Norm unit determines automatically whether to invert transmit timing, rece
timing is normal.

Tx Auto, Rx Invert unit determines automatically whether to invert transmit timing, rece
timing is inverted.

Operating Tx Timing  – displays the Transmit Timing options currently in effect.

Split Timing  – determines whether or not the unit can use External Clock from the DTE to 
channel Transmit Data while using Receive Timing at the network interface to transmit da
the T1 line.

Options:

Disabled inhibits external timing buffer for the unit. Default setting. 

Enabled allows external timing buffer for the unit.

Constant CTS – determines whether or not the unit maintains a constant Clear To Send o
to its DTE.

Options:

Disabled inhibits constant CTS. Default setting.

Enabled allows constant CTS.

Constant DCD – determines whether or not the unit maintains a constant Data Carrier De
output to its DTE.

Options:

Disabled inhibits constant DCD. Default setting.

Enabled allows constant DCD.

Constant DSR – determines whether or not the unit maintains a constant Data Set Ready o
to its DTE.
GDC 058R740-V300, Issue 1
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Options:

Disabled inhibits constant DSR. Default setting.

Enabled allows constant DSR.

Test Leads Control – determines whether or not DTE interface leads can initiate Remote Dig
Loopback (RDL) and Channel Local Loopback (AL). 

Options:

Disabled inhibits external loopback control. Default setting.

Enabled allows external loopback control.

Diagnostics

RDL Response – determines whether or not the unit accepts in-band polynomial commands
initiate and terminate remote digital loopbacks.

Options:

PN 127 permits the unit to accept PN 127 commands that initiate and terminate digital
backs. Default Setting. 

Disable prevents the unit from accepting in-band polynomial commands that initiate 
terminate digital loopbacks. 

RDL Auto Timeout  – determines whether or not the unit terminates remote digital loopbac
automatically. 

Options:

Disabled permits Remote Digital Loopbacks to remain in effect until terminated manua
Default Setting. 

10 Minutes limits the duration of a Remote Digital Loopback to 10 minutes. 

DS0 Allocation

Remember that the DS0 bundle you assign for channel data must start from a lower DS0 n
and extend to a higher DS0 number. The DS0 bundle cannot wrap around from the highe
bered DS0 of one frame to DS0 #1 of the next frame. For example, on a T1 frame that us
secutive DS0 allocation, a configuration with Starting DS0 = 20 and Number of DS0s = 5 
illegal because the DS0 bundle would have to wrap from DS0 #24 of one frame to DS0 #1
next. On the other hand, a starting of DS0 = 5 and an ending of DS0 = 20 is legal. 
 

Routing – selects which T1 interface the data from the DTE interface is directed to. Only N
work Port is valid when the cascade interface is not installed.  

Options:

To Network Port 

To Cascade Port 

Changing line type or number of DS0s brings down the WAN 
connection. Always configure the remote first, then the local DSU.

NOTE
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Allocation Scheme – lets you define the DS0 allocation scheme of the unit. 

Options:

Consecutive indicates that the DS0 bundles are allocated to channels in a consecutive
ion beginning with the starting DS0. Default setting. 

Alternate indicates that the DS0 bundles are allocated to channels in an alternate fas
beginning with the starting DS0. The unused DS0s are forced to marks. When altern
selected each channel requires twice the number of DS0s that supports its data rate

DS0 Format -selects the DS0 base rate. This option combined with Number of DS0s determ
the bandwidth of the channel. 

Options:

N x 64 defines the DS0 as clear channel, in which all 8 bits of the DS0 are used for ch
data. Default setting. 

N x 56 defines the DS0 as non-clear, in which bits 1-7 are used for channel data and t
bit is either unused (forced to marks) or used to pass signaling information.

Starting DS0 – selects the beginning DS0 for the bundle of DS0s that carry channel data. 

Options:

1 (Default setting) to 24

Number of DS0s – selects how many DS0s carry channel data. This option combined with 
format determines the bandwidth of the channel. 

Options:

1(Default setting) to 24

Aggregate Rate – read-only display that shows the rate that results from the selected DS0 F
and Number of DS0s. 

Remote Management

Remote Management Path – selects the type of inband Diagnostics Communication Chann
(DCC) in use.

Options:

None – no DCC being used for the channel. Default setting. 

Embedded – DCC embedded in the secondary channel (bit 8) of the DS0 bundle that ca
the channel 

DCC DS0 – DCC carried by an additional DS0 appended to the DS0 bundle that carrie
channel 

Network FDL – DCC carried in the Facilities Data Link channel provided by ESF fram

Routing Backup

Mode – selects whether or not the DSU is to perform automatic rerouting.

Options:

Disable – no automatic rerouting. Default setting. 

Enable –  automatic rerouting 
GDC 058R740-V300, Issue 1



Configuration 3-9
CSU Options
The TEAM SC 553 CSU Options window (Figure 3-3) lets you define the network and cascade 
interfaces of the selected unit. The cascade portion of this configuration screen is grayed out if 
the selected unit does not have the optional cascade interface installed. 
 

Figure 3-3 TEAM SC 553 CSU Options Window

Changing line type or number of DS0s brings down the WAN 
connection. Always configure the remote first, then the local DSU.

NOTE
GDC 058R740-V300, Issue 1
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Buttons

OK  – dismisses the window while retaining the changes you have made. The changes ar
stored permanently until you perform a Save to Unit or Save to Template at the Main Conf
tion window. 

Reset – replaces the information in the fields with the most recently read information from 
unit. Note that this button does not initiate a read of information from the unit.

Cancel – dismisses the window and cancels unsaved changes.

Network/Cascade Options

Port State – appears only in the Cascade column, determines whether or not the cacade p
active.

Options:

In Service – cascade port active. Default setting when the cascade is present.

Out of Service – cascade port inactive

Set Frame Type – sets the framing format.

Options:

ESF – Extended Superframe Format. Default setting.

D4 – D4 Superframe

Auto – unit adapts to ESF or D4 according to which is being received

Unframed 

Operating Frame Type – read-only field that displays the line type and framing format detec

ESF Mode – appears only in the Network column, when ESF is selected in the Set Frame
field (or in effect due to Auto framing) this option must be set to match the type of Facilities 
Link maintenance messages supported by the service provider.

Options:

None – no FDL. Default setting. 

ANSI T1.403 – Scheduled Performance Report Messages (PRMs) and Unscheduled
sages 

TR 54016 – Telemetry Asynchronous Block Serial (TABS) protocol 

Line Code – sets the line code.

Options:

B8ZS (Bipolar with eight zero substitution, with bipolar violations). Default setting.

AMI (Alternate Mark Inversion, with no bipolar violations)

Ones Density – appears only in the Network column, sets the technique the unit uses to en
that its transmit signal contains an adequate proportion of digital ones (minimum pulse de
when the Network Line Code option is set to AMI. This option is not available for the casc
interface. 

Options:

Disable – no minimum pulse density maintained. Default setting.
GDC 058R740-V300, Issue 1
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8 (N+1) – minimum of N ‘ones’ per 8(N+1) bits, where N = 1 to 24. Results in 12% aver
ones density. 

1 in 8 – minimum of 1 ‘one’ per 8 bits. Pulse density violations are enforced but enfo
ment is not indicated. 

Interface Type – sets the type of signal that the unit transmits and receives through T1 inte

Options:

DS1 – for connection to a Telco network; Line Buildout field is valid when DS1 is selec
Default setting.

DSX1 – for short haul connection to another on-site device; Pre-Equalization field is v
when DSX1 is selected 

Set Line Buildout – sets the Line Buildout (attenuation) value when DS1 is selected as the Interfac
Type.

Options:

0 dB – no attenuation. Default setting.

-7.5 dB

-15 dB

-22.5 dB

Auto – provides attenuation based on the signal being received from the network

Operating Line Buildout  – read-only field that displays the Line Buildout value currently in 
fect.

Pre-Equalization – sets pre-equalization when DSX1 is selected as the Interface Type. Sh
be set to match line length between the unit and the device it is connected to, thereby ens
that a satisfactory signal reaches the device.

Options:

None – no pre-equalization

0 – 130 ft (Default setting)

130 – 260 ft

260 – 390 ft

390 – 530 ft

530 – 655 ft

Inband Loopback Type – allows or prohibits the unit from accepting a formatted in-band lo
back code from another unit. The code initiates either Payload Loopback or Line Loopbac

Options:

None – prevents unit from accepting in-band loopback code. Default setting.

Payload Loop – unit enters Payload Loopback in response to in-band loopback code

Line Loop – unit enters Line Loopback in response to in-band loopback code 
GDC 058R740-V300, Issue 1
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AIS Loopdown – sets the amount of time (in seconds) that the unit must receive a continu
Alarm Indication Signal before terminating a remotely-initiated loopback. 

Options:

Disable – AIS cannot terminate remote loopback. Default setting.

5 – 60 seconds

Timing Options

Transmit Clock Source – selects the timing source for transmissions at the network interfa

Options:

Receive – timing derived from the incoming T1 signal at the network interface. Default
ting.

External/DTE – timing supplied at the channel interface

Internal – timing from the internal clock of the unit

Station – timing from an RS422 signal at the auxiliary port of the unit

Cascade – timing derived from the incoming T1 signal at the cascade interface 

Fallback Clock Source – selects transmit timing source the unit is to use if its primary timin
source is lost. 

Options:

Network Receive – timing from the incoming signal at the network interface

Internal – timing from the internal clock of the unit. Default setting.

Alarms Reported
The TEAM SC 553 Alarms Reported window (Figure 3-4) lets you designate the alarms that ar
to be masked (not reported) or unmasked (reported).
GDC 058R740-V300, Issue 1
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Figure 3-4 TEAM SC 553 Alarms Reported Window

Buttons

OK – dismisses the window while retaining the changes you have made. The changes are not 
stored permanently until you perform a Save to Unit or Save to Template at the Main Configura-
tion window. 

Reset – replaces the information in the fields with the most recently read information from the 
unit. Note that this button does not initiate a read of information from the unit.

Cancel – dismisses the window and cancels unsaved changes.

Report All – unmasks all unit alarms.

Report None – masks all unit alarms.

Options

Network and Cascade Alarms

Loss of Signal – occurs when the unit detects an absence of T1 signal. Absence of signal for a 
time equivalent to 175 bits (± 75) is considered no signal. 

Out of Frame – occurs when the unit misses two out of four framing bits in the signal it is re-
ceiving. The count for this alarm increments by one each time framing is lost, regardless of the 
number of frames affected. 

Alarm Indication Signal – occurs when the unit receives an AIS.

Unavailable Signal State – occurs in response to 10 consecutive severely errored seconds. The 
state is considered cleared when the unit has processed 10 consecutive seconds of data without a 
severely errored second. 
GDC 058R740-V300, Issue 1
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Received Yellow – occurs when a remote failure is detected.

Tx Timing Loss – occurs when the unit loses its source of Network Transmitter Timing. Th
is not a corresponding alarm for the cascade interface. 

Bipolar Violation  – lets you mask or unmask Bipolar Violation alarms. ABipolar Violation o
curs when the signal the unit receives does not alternate between signal levels as required
ternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8ZS) data encoding. 

If you unmask this alarm field, you must designate a window and a threshold. Window an
threshold settings are described below.

CRC Errors  – lets you mask or unmask CRC error alarms. A CRC error occurs when ESF 
ing is in use and the CRC-6 code calculated for a frame at the receiving unit does not ma
CRC-6 code calculated by the unit that transmitted the frame. The unit performs CRC che
on every ESF frame to detect errors in the DS1 signal. 

If you unmask this alarm field, you must designate a window and a threshold. Window an
threshold settings are described below.

Low Average Density – occurs when 8(N+1)Restrict is the configured selection for Ones D
sity and the unit has to insert ones in the signal it transmits toward the network. The unit i
ones when the transmit signal would otherwise contain fewer ones than the Ones Density 
requires. There is not a corresponding alarm for the cascade interface. 

If you unmask this alarm field, you must designate a window and a threshold. Window an
threshold settings are described below.

Window and Threshold settings – Bipolar Violation, CRC Errors, and Low Average Density
each, when unmasked, require you to designate a window and a threshold. The window d
a time period and the threshold sets an event count. The alarm is generated when the thr
count is exceeded within the limits of the window. For example, a window of Last One Min
and a threshold of >100 specify that more than 100 alarm events must be detected within t
minute window before an alarm is generated.

Window Options:

Report All – alarm is generated on every individual occurrence

Last One Second – alarm generated when threshold value exceeded within one secon

Last One Minute – alarm generated when threshold value exceeded within one minut

Last One Hour – alarm generated when threshold value exceeded within one hour

Report When – alarm generated when threshold value exceeded regardless of time

Threshold Options:

>10 – alarm generated when count exceeds 10 

>100 – alarm generated when count exceeds 100 

>1,000 – alarm generated when count exceeds 1,000 

>10,000 – alarm generated when count exceeds 10,000 

Channel Alarms

Data Carrier Detect Loss – occurs when the unit cannot recover data from the incoming sig
at the network interface 

Data Set Ready Loss – occurs when the unit is not outputting DSR to the DTE 

Data Terminal Ready Loss – occurs when the unit is not receiving the DTR signal from its DT
GDC 058R740-V300, Issue 1
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External Transmit Clock Loss – occurs when the unit has lost External Transmit Timing fro
its DTE; occurs only when unit is configured for External Timing

Receive Data No Transitions – occurs when RD being output to the DTE by the DSU cons
of all ones or all zeros 

Transmit Data No Transitions – occurs when TD coming to the DSU from the DTE consists
all ones or all zeros 

Alternate Route Active – occurs when the DSU reroutes the network signal  

Unit Alarms

Front Panel Test – occurs when a test is commanded by means of the front panel 

Unsolicited Test Mode – occurs each time the unit is commanded into a test mode by any m
other than SNMP or its front panel switches

Configuration Change – occurs when there is a change to the configuration of the unit. 

Remote Not Responding – occurs when the DSU loses communication with a dedicated rem

SC2000 Top Supply Failure – occurs only when DSU installed in an SC 2000 shelf detects 
ure of a shelf power supply installed in the upper position. 

SC2000 Bottom Supply Failure – occurs only when DSU installed in an SC 2000 shelf dete
failure of a shelf power supply installed in the lower position. 

System Options
The System Options configuration window contains two configuration options. 

Figure 3-5 System Options Configuration Window

Front Panel Switches – permits you to disable the switches on the DSU front panel to prev
inadvertent service interruptions. 

Options:

Enable – switches active. Default Setting. 

Inhibit – switches disabled 

Response Timeout – determines how long the application waits for a response from the DSU
fore declaring a No Response alarm. 

Options:

2 Seconds 

4 Seconds 

6 Seconds 

8 Seconds. Default Setting. 
GDC 058R740-V300, Issue 1
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4   Maintenance
Introduction
The TEAM SC 553 Maintenance application provides a group of functions for controlling 
operation of an SC 553 DSU. 

To Start TEAM SC 553 Maintenance 
You can start the TEAM SC 553 Maintenance application by either of two methods: 

• Select a DSU symbol on the submap in OpenView, then select the Maintenance op
from the Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration an
select Maintenance from the resulting menu. 

Maintenance Window Buttons
The Maintenance window provides the following three buttons. 

Reset Statistics – causes the unit to reset the counts of all near-end user statistics to zero 
intervals. 

Reset to Factory Defaults – causes all options in the unit to return to their factory default 
settings. When you click on this button the application displays a warning “Executing rese
factory defaults will disrupt communications to the unit. Do you want to continue?” Click on
to complete the reset, or Cancel not to perform the reset. 

Perform Soft Reset – causes the unit to perform a reset and resume operation using its cu
configuration. When you click on this button the application displays a warning “Executing
reset will disrupt communications to the unit. Do you want to continue?” Click on OK to 
complete the reset, or Cancel not to perform the reset. 

Figure 4-1 Maintenance Window
GDC 058R740-V300, Issue 1
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5 Diagnostics
Overview
The Fault menu provides access to the TEAM SC 553 Diagnostic screen, which provides
command and results display functions for all tests you can perform on the DSU by means
TEAM application. The diagnostics window displays the results of the most recent test unt
begin another one. There is also a Diagnostics History screen, accessible from the main 
nostic window, that displays results of all tests performed during the current session. 

The tests you can perform from the Diagnostics window divide into three categories: T1, 
and Channel. When using the diagnostic functions you should have the SC 553 DSU Installation 
and Operation Manual available as a reference. 

Diagnostics Window
The Diagnostics window has File, Navigate, and Help in its menu bar. The File menu has
selections: Status Poll, which enables you to set the window’s refresh rate in five second
ments from once every 35 seconds (default) to once every 5 seconds, and Exit, which dis
the application. The only selection in the Navigate menu is History, which causes the appli
to display the Diagnostics History window containing the results of all tests performed du
the current session. 

Below the Name field that identifies the selected SC 553 DSU the Diagnostics window co
of six panels: three for test selection, one for command functions, and two for display func

The test selection panels: 

T1 Tests – contains the selections for commanding tests that involve an entire T1 li
connected either to the DSU network interface or to the optional cascade interface 

DS0 Tests – contains the selections for commanding tests that involve one selected
in the T1 line at the network or cascade interface. By selecting a DS0 that is otherwis
in use, you can perform DS0 testing without interrupting or interfering with data traf
through the DSU. 

Channel Tests – contains the selections for commanding tests on the DTE interface 
the DSU 

The command function panel contains one input field and four buttons:

Test Time (input field) – selects how long a test is to run. The selections are 30 seco
through 10 minutes in 1-minute increments, 15 through 30 minutes in 5-minute 
increments, or Infinite.

Reset Bit Errors (button) – resets the Self Test error count to zero 

Insert Single Bit Error (button) – causes the pattern generator to transmit an error d
Self Test. Enables you to verify the diagnostic data path by observing that the error
detected. 
GDC 058R740-V300, Issue 1
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Start Test (button) 

Stop Test (button) 

The display panels: 

Data path panel – diagram of the route data follows during the selected test; there a
different layouts for this panel, depending on whether or not the selected DSU is equ
with the optional cascade interface 

Indicator panel – three fields: 

Test Status – Idle or Running 

Time Remaining – countdown gauge shows remaining percentage of the selecte
time 

Test Results 

Figure 5-1 TEAM SC 553 Diagnostics Window 
(shown with the cascade version of the data path panel) 
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T1 Tests
T1 tests employ the full capacity of the 24 DS0s connected to the DSU’s DS1 network inte
or its optional DSX1 cascade interface. The T1 Tests panel of the Diagnostics window pre
a list of eight tests from which to select, and a selection between running the chosen test 
network interface or at the cascade interface. The cascade selection is grayed out if the o
cascade interface is not installed in the DSU selected to be tested. 

Three of the T1 tests employ the T1-level Self Test generator/checker in the DSU. There a
selectable patterns (including programmable Binary Pattern) for T1-level Self Test. 

You select a test to run by clicking on the check box to the left of its name. You can de-sel
T1 tests by clicking the box next to None; that box is also selected automatically when you 
a DS0 or Channel Test. 

Five of the T1 tests, each involving DSU transmit data looped back as receive data, are com
ed entirely at the local DSU: 

• Local Test with Self Test

• Remote Test with Self Test

• Local Test 

• Remote Test 

• Network Interface Test 

The remaining three T1 tests each require that action be taken at the remote DSU, either
operator at that location or by SNMP control of the remote DSU: 

• Self Test

• Line Loopback

• Payload Loopback

Instructions for performing the T1 tests appear after the following descriptions. Each of th
descriptions is accompanied by two illustrations, labeled Network and Cascade, showing 
paths that are displayed on-screen for the two types of T1 tests. Remember that the casc
interface style of data path diagram appears for all tests performed on a DSU that has the c
interface installed. 

• Self Test - turns on the T1-level test pattern generator and checker in the DSU. Use o
test requires coordination with the remote device, either to establish a loopback or to
activate a test pattern generator and checker (using the same pattern) for an end-to-e

The TEAM SC 553 application polls the DSU at least once every 35 sec-
onds while the Diagnostics window is open. The poll rate is selectable 
in five second increments up to once every 5 seconds. In order to reduce 
unnecessary LAN traffic, the Diagnostics window should be closed 
when it is not in use. 

NOTE
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Network: 

Cascade: 

• Local Test with Self Test - turns on the T1-level test pattern generator and checker a
transmits the pattern through the local unit. The unit transmits the test data over the T
but does not accept incoming data at any interface during the test.

Network: 

Cascade: 

• Remote Loop with Self Test - commands the local DSU to send a loopback command
the remote DSU, then turns on the T1-level test pattern generator and checker and tra
the pattern through the loop. Evaluates local and remote units, and the T1 line. The r
DSU does either a line loopback or a Payload Loop depending on its configuration.
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Network: 

Cascade: 

• Local Test - commands the DSU to loop back the full T1 at the network or cascade 
interface. Test pattern generation and checking must be performed by equipment con
to the DSU, either at the front panel jacks or at the DTE interface. 
Network: 

Cascade: 

• Remote Test - commands the local DSU to send a loopback command to the remote
device. The remote device does either a line loopback or a Payload Loop depending
configuration. Test pattern generation and checking must be performed by equipme
connected to the local DSU, either at the front panel jacks or at the DTE interface. 

Network: 
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Cascade: 

• Line Loopback - commands the DSU to loop the received T1 signal back to the remo
the network or cascade interface. The remote site is responsible for test pattern gen
and checking. 

Network:

Cascade: 

• Payload - commands the DSU to loop the received T1 signal back to the remote at t
channel interface. The remote site is responsible for test pattern generation and che
Payload loopback tests everything on the network or cascade side up to and includi
unit. It generates Framing and corrects Bipolar Violations. 

Network: 
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Cascade: 

• NI Loop  - commands the local DSU to send a loopback command to the Smart Jack
equivalent network terminating device) that connects it to the T1 network. The jack 
responds by looping the T1 signal back to the DSU. Test pattern generation and che
must be performed by equipment connected to the local DSU, either at the front pane
or at the DTE interface.

Network: 

Cascade: 

T1 Test Instructions

Perform the following steps to carry out a T1 test: 

1. If you are going to perform Self Test, Line Loopback, or Payload Loopback, make the
essary arrangements concerning the remote device. Arrangements may involve con
remote-site personnel or SNMP control of the remote device. Actions you need to a
can be loopback initiation (for use with Self Test) or test signal generation and checki
part of an end-to-end Self Test, or in conjunction with a Line or Payload Loopback). 

2. Select the test you intend to perform by clicking on the check box to the left of its 
and, if it is applicable, by selecting either Network or Cascade. 

If the selected test is not one that involves Self Test, go to step 4. 

3. Select the Self Test Pattern by clicking on the check box to the left of its name. 

If you select Binary Pattern, click in the Binary Pattern input field and type the sequen
1’s and 0’s you intend to use. The pattern is 16 bits long. If you enter fewer tha
characters, the application pads the pattern with 1’s. 
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4. Click on the Test Time input field and select how long you intend the test to run. 

5. Click on the Start Test button. The data path display panel exhibits the path for the te
have selected, the Test Status field changes from Idle to Running, and the Time Rem
gauge begins to display its countdown. 

If you are running a Self Test, the Reset Bit Errors and Insert Single Bit Error button
available while the test runs. The reset button returns the error count to zero. The
button generates an error in the pattern in order to confirm transmission and receptio
Stop Test button is available during any test. 

6. Upon completion of the selected Test Time the application displays results in the Te
sults window. 

DS0 Tests
If the data link between units does not employ the full capacity of the T1 line, DS0 Tests p
you to check the reliability of the link without interrupting data. To do that, take care to spe
as the DS0 to be tested one that is not being used by the data link. 

The DS0 Tests panel of the Diagnostics window presents a list of three tests from which to 
and a selection between running the chosen test at the network interface or at the cascad
face. The cascade selection is grayed out if the optional cascade interface is not installed
DSU selected to be tested. 

You select a test to run by clicking on the check box to the left of its name. You can de-sel
DS0 Tests by clicking the box next to None; that box is also selected automatically when 
select a T1 or Channel Test. 

DS0 Loopback is commanded entirely at the local DSU. Use of Self Test or DS0 Circuit D
requires that action be taken at the remote DSU, either by an operator at that location or by
control of the remote DSU. There are two selectable patterns for DS0-level Self Test. 

Instructions for performing the DS0 tests appear after the following descriptions. Each of t
descriptions is accompanied by two illustrations, labeled Network and Cascade, showing 
paths that are displayed on-screen for the two types of DS0 tests. Remember that the cas
interface style of data path diagram appears for all tests performed on a DSU that has the c
interface installed. 

• Self Test - commands the local DSU to generate a DS0-level test pattern and transm
the remote, and also to turn on its DS0-level test pattern checker. Can be used in an 
end test to evaluate the local and remote DSUs, and the T1 link. The remote must b
independently commanded to turn on DS0-level test pattern generation and checking
DSU checks the test pattern transmitted to it by the other.

Network:
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Cascade: 

• DS0 Circuit Delay – computes, for a selected channel, round-trip transmission delay o
internally-generated message from the local unit to the remote unit and back to the 
The delay includes variables like circuit distance, transmission path, etc. Hence, no fi
of acceptable delay are presented here. The result is an indication of network respon
and throughput that can be compared to results of the same test repeated under sim
conditions at other times. Initiating the Circuit Delay test does not command the req
DS0 loopback at the remote unit; it has to be commanded at that unit, either by an op
at the remote site or by SNMP control. 

Network

Cascade: 

• Loopback – loops one DS0 of channel data back toward the network interface. 

Network
GDC 058R740-V300, Issue 1
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Cascade: 

DS0 Test Instructions

Perform the following steps to carry out a DS0 Test: 

1. Use the arrow buttons next to the DS0 Number input field to select the DS0 you inte
use for testing. If possible, select a DS0 that is not in use for channel data, so that te
be performed with no interference to data traffic. 

2. Select the test you intend to perform by clicking on the check box to the left of its n
and, if it is applicable, by selecting either Network or Cascade. 

If the selected test is DS0 Loopback, go to step 5. 

3. If you are going to perform Self Test or Circuit Delay test, make the necessary arr
ments with the remote site. Arrangements may involve contacting remote-site person
SNMP control of the remote DSU. Actions you need to arrange can be loopback init
for either a Self Test or a Circuit Delay test, or test signal generation and checking 
end-to-end Self Test. Make sure the same DS0 is selected at both sites. 

4. Select the Self Test Pattern by clicking on the check box to the left of its name. 

5. Click on the Test Time input field and select how long you intend the test to run. 

6. Click on the Start Test button. The data path display panel exhibits the path for the te
have selected, the Test Status field changes from Idle to Running. For a Self Test o
Loopback the Time Remaining gauge begins to display its countdown. 

If you are running a Self Test, the Reset Bit Errors and Insert Single Bit Error button
available while the test runs. The reset button returns the error count to zero. The
button generates an error in the pattern in order to confirm transmission and receptio
Stop Test button is available during any test. 

7. Upon completion of the selected Test Time the application displays results in the Te
sults window. 
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Channel Tests
Channel Tests interrupt the data link between units, since they employ all of the DS0s tha
assigned to carry channel data. The Channel Tests panel of the Diagnostics window presen
of six tests from which to select, three of which involve the use of the channel-level Self Tes
erator/checker in the DSU. There are two selectable patterns for channel-level Self Test. 

You select a test to run by clicking on the check box to the left of its name. You can de-sel
Channel Tests by clicking the box next to None; that box is also selected automatically whe
select a T1 or DS0 Test. 

Four of the Channel Tests, each involving DSU transmit data looped back as receive data
commanded entirely at the local DSU: 

• Local Loop with Self Test

• Remote Data Loop with Self Test

• Local Loop 

• Remote Data Loop 

The remaining two Channel Tests each require that action be taken at the remote DSU, ei
an operator at that location or by SNMP control of the remote DSU: 

• Self Test

• Digital Loop

Instructions for performing the Channel Tests follow the descriptions that appear below. T
illustration that accompanies each description is the data path for the test, as displayed on-

• Self Test - commands the local DSU to generate a channel-level test pattern and tra
it to the remote, and also to turn on its channel-level test pattern checker. Can be use
end-to-end test to evaluate the local and remote DSUs, and the T1 link. The remote
be independently commanded to turn on channel-level test pattern generation and 
checking. Each DSU checks the test pattern transmitted to it by the other.

• Local Loop with Self Test – commands the DSU to turn on its channel-level test patte
generator and checker and to loop data back at the channel interface. Local Loopbac
Self Test checks the channel interface circuitry isolated from both the DTE and the r
the DSU. During this test the DSU clamps channel data transmitted to the T1 link.
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• Remote Data Loop with Self Test – commands the DSU to transmit an in-band code th
puts the remote DSU in Digital Loopback. The local DSU then turns on its channel-le
test pattern generator and checker, and transmits its test pattern to the remote DSU
loops it back. The local DSU checks for errors in the test pattern it receives back. Eva
local and remote units, and the T1 line. 

• Local Loop – loops channel data that the local unit receives from its DTE back toward
DTE at the channel interface. Local Loop checks everything up to the channel interf
During this test the unit clamps channel data transmitted to the T1 link. 

• Digital Loop – loops channel data that the local unit receives from the network back tow
the network at the channel interface. 

• Remote Data Loop – causes the local DSU to transmit an in-band code that comman
Digital loopback at the remote DSU. In order for a DSU to have its Digital Loopback 
controlled by in-band codes, it must have Respond to RDL enabled in its Channel 
Configuration screen.
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Channel Test Instructions

Perform the following steps to carry out a Channel Test: 

1. If you are going to perform Self Test or Digital Loop, make the necessary arrangements
with the remote site. Arrangements may involve contacting remote-site personnel or SNMP
control of the remote DSU. Actions you need to arrange can be loopback initiation (for use
with Self Test) or test signal generation and checking (as part of an end-to-end Self Test,
or in conjunction with Digital Loop). 

2. Select the test you intend to perform by clicking on the check box to the left of its name. 

If the selected test is not one that involves Self Test, go to step 4. 

3. Select the Self Test Pattern by clicking on the check box to the left of its name. 

4. Click on the Test Time input field and select how long you intend the test to run. 

5. Click on the Start Test button. The data path display panel exhibits the path for the test you
have selected, the Test Status field changes from Idle to Running, and the Time Remaining
gauge begins to display its countdown. 

If you are running a Self Test, the Reset Bit Errors and Insert Single Bit Error buttons are
available while the test runs. The reset button returns the error count to zero. The insert
button generates an error in the pattern in order to confirm transmission and reception. The
Stop Test button is available during any test. 

6. Upon completion of the selected Test Time the application displays results in the Test Re-
sults window. 

Diagnostics History
You can view a record of tests performed during the current diagnostic session by selecting 
History from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 5-2). 

Figure 5-2 Diagnostics History

The Diagnostics History displays information in five columns:

Start Time – date and time test began 

Test – name of the test 

Pattern – test pattern used for the test; shows a dash (-) when internally generated pattern 
is not used 

DS0 Number – identifies DS0 used for testing, valid only for DS0 tests
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Test Time – duration of the test 

Test Results – “Idle: n Errors” for a completed test with test pattern; “Not in loop 
[STOPPED]” for a completed loop test without test pattern 

Test Results – displays “OK” for successfully completed loopback test without self te
appropriate combination of “n Bit Errors”, “No Sync”, “Bit Over Range” for self tests; 
“Remote Data did not loop” with or without further information for a failed Remote Lo
test; n milliseconds or “Delay Over Range” for Circuit Delay test 

To close the Diagnostics History window, click on either the OK button or the pushpin icon
the upper left corner of the window. During an on-going diagnostic session you can close a
open the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window
GDC 058R740-V300, Issue 1
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